What is mail merge?

You've probably heard it mentioned around the office or at an interview (especially for a temp agency). You may have heard it referred to with an almost mystical quality.

So, what is mail merge exactly? Quite simply, it is a way of placing content from a spreadsheet, database, or table into a Microsoft Word document. Mail merge is ideal for creating personalized form letters or labels instead of editing the original letter several times to input different personalized information. As you can imagine, this can save a lot of time as well as worry about not changing all of the information for the new recipient.

In order to create a mail merge, two documents are needed: a Word document and a file with the data or records. This file can take many forms, such as an Excel spreadsheet, a database, or even another Word document that has a table in it. In this tutorial I will be using an Excel spreadsheet.

At the end of this tutorial, you should be able to:
1. Create a new mail merge from a document and a data source using the PC Mail Merge Sidebar Wizard.
2. Edit an existing merged document using the Mail Merge Toolbar or Mailings Tab.
3. Get a taste for creating and editing mail merge on a Mac.

This tutorial assumes a basic proficiency with Word and Excel.
Part I: Creating Mail Merge on a PC using the Mail Merge Sidebar Wizard

Before creating a mail merge, it is important to already have your data source ready. Although it is not necessary, I have found that it is easiest to have your Word document set up beforehand as well. Therefore, I have already created a form letter in Microsoft Word and entered my data into a Microsoft Excel spreadsheet.

Here is what my spreadsheet looks like. I used the first row to name my fields and entered the appropriate data in the rows below. As you will see later, naming your rows is very important when it comes to using mail merge. Also, notice how there are two worksheets in my spreadsheet; this will also be important later.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>First Name</td>
<td>Last Name</td>
<td>Address1</td>
<td>Address2</td>
<td>City</td>
<td>State</td>
<td>Zip</td>
<td>Donation amt</td>
</tr>
<tr>
<td>2</td>
<td>Lee</td>
<td>Adams</td>
<td>9887 Gemenon St</td>
<td></td>
<td>Galaxy</td>
<td>BS</td>
<td>45125</td>
<td>550.00</td>
</tr>
<tr>
<td>3</td>
<td>Kaylee</td>
<td>Frye</td>
<td>607 Airlock St</td>
<td>Apt 4</td>
<td>Serenity</td>
<td>FF</td>
<td>01111</td>
<td>100.00</td>
</tr>
<tr>
<td>4</td>
<td>Sara</td>
<td>Heart</td>
<td>522 Kain Blvd</td>
<td></td>
<td>Disney</td>
<td>WD</td>
<td>99999</td>
<td>100.00</td>
</tr>
<tr>
<td>5</td>
<td>Tidus</td>
<td>Jedid</td>
<td>74 Yuna St</td>
<td>Apt 22</td>
<td>Square</td>
<td>FF</td>
<td>02200</td>
<td>100.00</td>
</tr>
<tr>
<td>6</td>
<td>Mickey &amp; Minnie Mouse</td>
<td>1 Disney St</td>
<td></td>
<td>Disney</td>
<td>WD</td>
<td>99999</td>
<td>5000.00</td>
<td>4</td>
</tr>
<tr>
<td>7</td>
<td>Mal</td>
<td>Reynolds</td>
<td>807 Airlock St</td>
<td>Apt 1</td>
<td>Serenity</td>
<td>FF</td>
<td>01111</td>
<td>250.75</td>
</tr>
<tr>
<td>8</td>
<td>Luke</td>
<td>Skywalker</td>
<td>23 Hoth Way</td>
<td></td>
<td>Dagoba</td>
<td>SW</td>
<td>56707</td>
<td>1000.00</td>
</tr>
<tr>
<td>9</td>
<td>Leia</td>
<td>Skywalker</td>
<td>23 Hoth Way</td>
<td></td>
<td>Dagoba</td>
<td>SW</td>
<td>56767</td>
<td>1250.00</td>
</tr>
<tr>
<td>10</td>
<td>Cara</td>
<td>Trace</td>
<td>383 Cappica Ave</td>
<td>Apt 436</td>
<td>Galaxy</td>
<td>BS</td>
<td>46125</td>
<td>200.50</td>
</tr>
<tr>
<td>11</td>
<td>Simon</td>
<td>Tam</td>
<td>807 Airlock St</td>
<td>Apt 8</td>
<td>Serenity</td>
<td>FF</td>
<td>01111</td>
<td>2000.00</td>
</tr>
</tbody>
</table>

This is my Word document. As you can see, when I created the letter, I used < > to mark where I want variable content to be placed and even entered what the content is supposed to be (i.e.: <Last Name>, <Zip Code>).

Notice how the variable content corresponds to the fields in the spreadsheet above. It is okay that the wording is not exactly the same: for example “Address1” and “Address Line 1.”

February 2, 2007

<First Name> <Last Name>
<Address Line 1>
<Address Line 2>
<City> <State> <Zip Code>

Dear <First Name> <Last Name>,

We would like to thank you for your donation of $<money> to our Giant Corporation. It is donations from generous people, such as yourself, that help to keep our business running.

We will be holding our Annual Giant Corporation Gala at The Really Nice Hotel in Somewhere, State on April 28, 2007 and would love for you to join us there. Per your request on our donation form, we have enclosed <number> ticket(s) to the event. If you need more tickets or have any other questions, please do not hesitate to give our office a call at 1-800-555-4252.

Once again, we thank you for your donation and we look forward to seeing you in April.

Sincerely,

Alison King
VP of People Giving Us Money
Giant Corporation
Opening the Mail Merge Sidebar Wizard

If you are using **Word 2003**, open your letter in Word and then bring up the Mail Merge Sidebar Wizard by going to Tools > Letters and Mailings > Mail Merge.

If you are using **Word 2007**, click on the Mailings Tab on the Ribbon then click on Start Mail Merge and select Step by ‘Step Mail Merge Wizard’.

**Step 1**

The sidebar to the right will appear on the right side of the window, next to your document.

Since I am working on a letter, I will leave the ‘Letters’ option checked and click on ‘Next: Starting document’ at the bottom of the sidebar.

As you can see, there are other options such as ‘Envelopes’ and ‘Labels’, which will give you slightly different options as you walk through the steps. No matter which option you choose, the basic concept is still the same.

**Step 2**

At this step nothing needs to be done, because I already have the document that I want to use open. Leave the ‘Use the current document’ checked and click on ‘Next: Select recipients’ to move on.

If you have not created your letter already, use this step to do so by selecting either of the other two options shown.

If, instead of a letter, you were merging to labels or envelopes, this step would give you the option to select the type and size of labels or envelopes, such as Avery 5160 labels.
Step 3

This is the step in which the data source is linked into the Word document.

As you can see there are three options for this: ‘Use an existing source’, ‘Select from Outlook contacts’, and ‘Type a new list’.

I would caution against using the ‘Type a new list’ option as the list it creates can often be difficult to manage. To use the Outlook contacts, you must already be using a Microsoft Outlook address book, so if you do not already use Outlook for your e-mail, then this option will not work for you.

This leaves the first option, using an existing list. This is why I’d already entered the data I wanted to use into a spreadsheet before I started the mail merge process.

In order to tell Word where the data source is, click ‘Browse.’ Navigate to the folder where your data source is located and double click on its name to select it.

Because there are two worksheets on the spreadsheet that I selected, the following window pops up, prompting me to select one.

Since my data is on the worksheet called “donors 2006” (see Page 2 of this tutorial), I select that one. As I have column names in the first row of my spreadsheet, I also make sure that the ‘First row of data contains column headers’ box is checked before clicking OK.
After selecting the tab that has the data source, another window pops up to confirm the mail merge recipients. If there is someone on the list that you know you do not want to receive the letter, then you can uncheck the box next to that person’s row. However, in this case, as with most cases, I want all of my recipients to receive the letter, so I will just click the ‘OK’ button.

At this point, instead of ‘Browse’, the Mail Merge Sidebar now tells me the tab name and data source where Word will be getting the merge information. If you accidentally select the wrong source, or if you want to change sources at a later date, you can click ‘Select a different list’ and browse to it in the same way you chose the first source.

Clicking ‘Edit recipient list’ will bring up the Mail Merge Recipients window from above. This will allow you to remove a specific record or just double check that you selected the correct set of data for your merge.

Once you are sure that you have selected the correct data source, then click on ‘Next: Write your letter’ to go to the next step.
Step 4

Now we get to the fun part, inserting recipient information from the data source into the Word document. As you can see, there are a number of different options for types of items to insert. If you pick any of the first four options, then Word will match the fields that you have in your data source to what it believes are the corresponding fields that it has for the items. This is called “mapping.” However, I have found that Word does not always get the mapping correct.

Therefore, I always use the ‘More items’ option. This gives me more control over where and how the fields from my data source are inserted.

To do this, first select the place in the document where you want to insert a field from the data source and click on ‘More items’. A box will pop-up, giving you a list of all of the fields that are possible to insert. (Remember how in Step 3 I told Word that the headers were in our top row? This is why.) Select the field that you want to insert and click ‘Insert’. It will replace the selected section of text with “<field_name>.”

February 2, 2007

<First Name> <Last Name>
<Address Line 1>
<Address Line 2>
<City>, <State> <Zip Code>

Dear <First Name> <Last Name>,

We would like to thank you for your donation to our Corporation. It is donations from generous people like you that help to keep our business running.

We will be holding our Annual Gala Somewhere, State on April 28, 2007. We are now accepting your request on our donation form for the event. If you need more tickets or have any other questions, please do not hesitate to give our office a call at 1-800-555-4252.

Once again, we thank you for your donation and we look forward to seeing you in April.
Here is my letter with all of the fields merged in. Compared to the pre-merged version on Page 2, you can see that the merged fields are in the same places and have very similar names (because I called most of them the same thing).

However, if you look at where “<numbers>” was it now says “M_of_Tickets.” If you look at the data field from the Excel file, you will notice that it is titled “# of Tickets.” Mail merge has trouble converting spaces and some characters and spaces into Word, so it will replace them with its own formatting. There is no need to worry about this.

Also, note the spacing around the fields. Word will merge in the data exactly where the fields are placed. So, if you want a space between someone’s «First_Name» and «Last_Name», you have to make sure that is there in your document.

Once you have entered all of your merged fields into the correct places and checked the formatting around them, click on ‘Next: Preview your letters’.
Step 5

At this step you are able to preview your letters to make sure that everything will look correct once the records from the data source are merged. You can check different recipients’ letters by using the arrows, look for a specific record by searching the merge fields, or even ‘exclude’ one from the merge.

At this step I always spot check at least 4 or 5 recipients (depending on the size of my list) to make sure that all of the merge fields look right. This is how the letter looks with the information from the first recipient on my list filled in.

Lee Adama
9887 Genmon St
Galactica BS 45125

Dear Lee Adama,

We would like to thank you for your donation of $550 to our Giant Corporation. It is donations from generous people, such as yourself, that help to keep our business running.

We will be holding our Annual Giant Corporation Gala at The Really Nice Hotel in Somewhere, State on April 28, 2007 and would love for you to join us there. Per your request on our donation form, we have enclosed 1 ticket(s) to the event. If you need more tickets or have any other questions, please do not hesitate to give our office a call at 1-800-555-4252.

Once again, we thank you for your donation and we look forward to seeing you in April.

As you can see, all of the fields filled in exactly the way that I wanted them to. Note that because this recipient has nothing in the “Address2” column of the spreadsheet, that line simply does not appear in his letter. Also, notice how even though the “Donation amt” is formatted in Excel as ‘Accounting’, the cents are not showing up in the letter. I will show you how to fix this in Part III of the tutorial.

<table>
<thead>
<tr>
<th>First Name</th>
<th>Last Name</th>
<th>Address1</th>
<th>Address2</th>
<th>City</th>
<th>State</th>
<th>Zip</th>
<th>Donation amt</th>
<th># of Tickets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lee</td>
<td>Adama</td>
<td>9887 Genmon St</td>
<td></td>
<td>Galactica</td>
<td>BS</td>
<td>45125</td>
<td>$550.00</td>
<td>1</td>
</tr>
<tr>
<td>Kaylee</td>
<td>Frye</td>
<td>607 Aftlock St</td>
<td>Apt 4</td>
<td>Serenity</td>
<td>FF</td>
<td>10111</td>
<td>$100.00</td>
<td>2</td>
</tr>
<tr>
<td>Sara</td>
<td>Head</td>
<td>633 Ked Plst</td>
<td></td>
<td>Florence</td>
<td></td>
<td>20030</td>
<td>$100.00</td>
<td>1</td>
</tr>
</tbody>
</table>

After spot-checking a couple of records, click ‘Next: Complete the merge’. 
**Step 6**

Once you are happy with the way that your merge is set up, it is time to complete it. You can choose to either print the letters or view the merge as individual letters.

Either option will bring up the box below. You can choose to merge all of the records in the data source, just the ‘Current record’ that you are displaying in the preview, or a certain section of continuous records.

Note: If you are selecting a certain selection of records from an Excel document, remember that the first row is the Merge field names. Therefore, if you want just rows 3-7 in Excel, you need to type in “2 to 6.”

By selecting ‘Print’, Word will send your merge directly to your printer. Each letter it prints out will have a new recipient’s set of data populating the merge fields (as it looks in the preview step). Only choose this step if you are 110% sure that everything is exactly how you want it.

Selecting ‘Edit individual letters’ will open up a new Word document (usually called “Letters 1”). In this document, each page will contain the form letter with one of the records merged into it. You can then edit individual letters if you want to, for example if you want to add a message to a specific recipient. It’s also a good way to do a final check that everything is correct before printing. This is my preferred method when I use mail merge. From this new document, you can just print as normal.

Sometimes there will be a third option: ‘Merge to email’. This option is only available if you are using a Microsoft email program, such as Outlook, and if you have “e-mail address” as one of your data fields.

And that’s it. You have now created a mail merge. See? It really isn’t that hard once you learn the steps.
Part II: Mail Merge on a PC using the Mail Merge Toolbar or Mailings Tab

This is the Mail Merge Toolbar for Word 2003. It can be viewed by going to the menu bar and selecting View > Toolbars > Mail Merge.

The Mail Merge Toolbar can be used to either edit a merge which has been previously set up or to create a new one (if you don’t like using the Mail Merge Sidebar).

The first section is like Steps 2 & 3, creating the letter and choosing the data source. You can use the Open Data Source button (second one) to change data sources in an already merged document. This is very useful if you have to send out the same letter over and over again, but the list of recipients changes each time. Just click the button and browse to your new data source.

The second section is like Step 4, allowing you to add fields from your data source. The third button is the ‘Merge Fields’ button which behaves like the ‘More items’ choice.

The Insert Word Field will be explained in Part III.

The fourth and fifth sections are like Step 5. To preview a record, click on the ‘ABC’ button. Then you can move through them with the arrow keys or search with the binoculars. Also, the button next to the ‘ABC’ one will highlight the merged fields, which gives you yet another way to make sure that everything is in the correct place and formatted the way that you want it to be.

The last section is like Step 6, allowing you to print the merged letters or open them in a new document.
This is the Mailing Contextual Tab for **Word 2007**. It can be viewed clicking the Mailings Tab on the Ribbon.

![Mailing Contextual Tab for Word 2007](image)

Just like the Mail Merge Toolbar, the Mailings Tab can be used to either edit a merge which has been previously set up or to create a new one (if you don’t like using the Mail Merge Sidebar).

The ‘Create’ group lets you create an Envelopes or Labels mail merge.

![Create group](image)

The ‘Start Mail Merge’ group is like Steps 2 & 3, creating the letter and choosing the data source. The ‘Start Mail Merge’ button lets you start a mail merge or to pull up the Sidebar Wizard. You can use the ‘Select Recipients’ button to change data sources in an already merged document. This is very useful if you have to send out the same letter over and over again, but the list of recipients changes each time. Just press the button, choose an existing list, and browse to your new data source.

![Start Mail Merge group](image)

The ‘Write & Insert Fields’ group is like Step 4, allowing you to add fields from your data source. The ‘Insert Merge Field’ button which behaves like the ‘More items’ choice. The ‘Highlight Merge Fields’ will highlight the merged fields already in the document. The ‘Rules’ button will be explained in Part III.

![Write & Insert Fields group](image)
The ‘Preview Results’ group is like Step 5. To preview a record, click on the ‘Preview Results’ button. Then you can move through them with the arrow keys or search with the ‘Find Recipient’ button. Don't forget about the ‘Highlight Merge Fields’ button from the previous section, which gives you another way to make sure that everything is in the correct place and formatted the way that you would like it to be.

The last group is like Step 6, by clicking on ‘Finish & Merge’ you can print the merged letters or open them in a new document. You can also choose to merge them to an Adobe PDF.
Part III: Tips and Tricks

1. Excel formatting
The biggest problem with Mail Merge is that Word will often import the data without any formatting at all. Remember that the amount in the preview didn’t have cents?

I ran into this problem a lot when I was merging zip codes that started with 0 (as many in New England do). Although my zip codes looked fine in Excel, when I brought them into Word, they would lose the first 0. The way that I dealt with this is to make sure that the zip code field in Excel was formatted as ‘text’ instead of as a ‘number’ or ‘zip code’. You may have noticed the little green arrows in the “Zip” column of my spreadsheet (see below). This is Excel’s way telling me that I have a number stored as text.

When I bring up the preview for Recipient 2, who has a zip starting with a 0, you can see that it appears with the leading 0.

I can correct the money display problem the same way. First, I have to close Word (because otherwise the computer will consider the Excel file already open and will not let me edit it). Then I open my Excel file, change all of the entries in my “Donation amt” column to be formatted as text, and add the cents where needed (there are shortcuts for doing this, but that’s for a different tutorial). As you can see, it looks almost the same in Excel, but the difference in Word is dramatic.

<table>
<thead>
<tr>
<th>SS2</th>
<th>City</th>
<th>State</th>
<th>Zip</th>
<th>Donation amt</th>
<th># of Tickets</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Galactica</td>
<td>ES</td>
<td>25125</td>
<td>550.00</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>Serenity</td>
<td>FF</td>
<td>01111</td>
<td>100.00</td>
<td>2</td>
</tr>
<tr>
<td>12</td>
<td>Disney</td>
<td>WD</td>
<td>90999</td>
<td>500.00</td>
<td>4</td>
</tr>
<tr>
<td>12</td>
<td>Square</td>
<td>NY</td>
<td>02001</td>
<td>100.00</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>Disney</td>
<td>WD</td>
<td>99999</td>
<td>250.75</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>Serenity</td>
<td>FF</td>
<td>01111</td>
<td>250.00</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>Dagoba</td>
<td>SW</td>
<td>18767</td>
<td>1000.00</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>Dagoba</td>
<td>SW</td>
<td>18767</td>
<td>1250.00</td>
<td>3</td>
</tr>
<tr>
<td>12</td>
<td>Galactica</td>
<td>ES</td>
<td>45125</td>
<td>200.00</td>
<td>2</td>
</tr>
</tbody>
</table>

Dear Cara Thrace,

We would like to thank you for your donation of $200.00 to our Giant Corporation. It is donations from generous people, such as yourself, that help to keep our business running.

We will be holding our Annual Giant Corporation Gala at The Really Nice Somewhere, State on April 28, 2007, and would love for you to join us then. Your request or our donation form. We have enclosed 2 ticket(s) in the envelope with this letter. If you need more tickets or have any other questions, please do not hes

2. If…Then…Else
‘If…Then…Else’ statements can also be a really great way of making sure your letter looks less like a form letter and more like a personalized letter. Look at the, “we have enclosed 2 ticket(s)” line above. Wouldn’t it be better if it said “ticket” when the number was 1 and “tickets” when it was more than one? Mail Merge lets you do that with the use of ‘If…Then…Else…’ statements.
To insert an ‘If…Then…Else…’ statement, highlight the location in your letter where you want it to go. Then select the ‘Insert Word Field’ on the Mail Merge toolbar and choose ‘If…Then…Else…’

Once it is clicked, an ‘Insert Word Field: IF’ box will appear. In this case, I want to set it up so that if the number of tickets equals 1, then the document should say “ticket.” Otherwise, it should say “tickets.” I used the pull down menus to select the ‘Field Name’ “M_of_Tickets” and the ‘Comparison’ “Equals to.” Then I filled out the rest of the boxes to fit my desired specifications.

Now, when I look at my preview, it will say either “ticket” or “tickets” depending on the number of tickets entered into the “# of Tickets” column in my spreadsheet.

Dear Cara Thrace,

We would like to thank you for your donation of $200.50 to our Giant Corporation. It is donations from generous people, such as yourself, that help to keep our business running.

We will be holding our Annual Giant Corporation Gala at The Really Nice Hotel Somewhere, State on April 28, 2007 and would love for you to join us there. If you need more tickets or have any other questions, please do not hesitate to contact our office at 1-800-555-4253.
Part IV: Mail Merge on a MAC using the Data Merge Manager

This is the Data Merge Manager Toolbar for the Mac version of Word. Don't let the name fool you. It does the same thing as the Mail Merge bars in the Windows version. It can be viewed by going to the menu bar and selecting Tools > Data Merge Manager.

As you can see, it is very similar to the Mail Merge toolbar in the PC version of Word.

The first section is like Step 2, selecting the document type.

The second section is like Step 3, selecting the data source.

The third section is like the Insert Word Field from Tips and Tricks.

The fourth section is like Step 4, allowing you to add fields from your data source. As you can see, there is no mapping in this version, but you do have the ability to just drag and drop the fields into your document.

The fifth section is like Step 5 and works the same way as the Mail Merge toolbar.

The last section is like Step 6, allowing you to print the merged letters or open them in a new document. It even lets you select which records you want to use right there.